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Chapter 1. System requirements and
compatibility

Unica Journey is part of the Unica suite of products. Unica Journey version 12.1.2 requires
Unica Platform 12.1.2.

Where to find complete system requirement and compatibility information

For a list of Unica product versions compatible with Unica Journey and a list of third-party
requirements for this product, see the Recommended Software Environments and Minimum

System Requirements document.

You can also access this document by selecting Help > Product documentation when you

are logged in to Unica.

Prerequisites for using Unica Journey

Before you begin using Unica Journey, confirm that your environment meets the following

requirements:

« For an improved user experience, use at least a 21-i nch screen.

« For an improved user experience, set your screen resolution to 1600x900. Lower
resolutions can result in some information not being properly displayed. If you use a
lower resolution, maximize the browser window to see more content.

« Amouse is best for navigating in the user interface.

« Do not use the browser controls to navigate. For example, avoid using the Back and
Forward buttons. Instead, use the controls that are in the user interface.

« If pop-up blocker (ad blocker) software is installed on the client machine, Unica
Journey might not function properly. For best results, disable pop-up blocker software
while running Unica Journey.

« Ensure that the technical environment meets the minimum system requirements and
the supported platforms. For more information, see the Recommended Software

Environments and Minimum System Requirements document.
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» The correct browser and versions must be used. For more information, see the

Recommended Software Environments and Minimum System Requirements

document.

- Clear the browser cache after installation. This only needs to be done once, after the

application is updated.

Important: Do not use any other method to open multiple sessions. For example,

do not open a new tab; do not open another browser session from the Start menu

or desktop icon; and do not use File > New Window in Microsoft Internet Explorer.

These methods can corrupt information that is shown in the application.

Unica Journey documentation roadmap

Unica Journey provides documentation that helps users like marketers, administrators, and

developers to get their hands on the product functionality.

Table 1. Get up and running

Task

Documentation

Find out about the new features in the
product

For the first release, all new features are

available in the Unica Journey User Guide

Find out about the known issues and limi-

tations

Unica Journey Release Notes

Learn about the structure of the Unica

Journey system tables

Unica Journey System Schema

Installation and configuration of Unica

Journey

Unica Journey Installation Guide

Upgradation and configuration of Unica

Journey

Unica Journey Upgrade Guide
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Table 2. Installing and Configuring Unica Link

Task

Documentation

Installation and configuration of Unica
Link

Unica Link Installation Guide

Installing Unica Link connector app for

Journey

Unica Link Installation Guide

Installing Unica Link connector -
MailChimp

Unica Link Mailchimp Connector User
Guide

Installing Unica Link connector — Mandrill

Unica Link Mandrill Connector User
Guide

Installing Unica Link connector — Twilio

Unica Link Twilio Connector User Guide

Installing Unica Link connector — Sales-

force

Unica Link Salesforce Connector User
Guide

Table 3. Integrate Unica Campaign with other HCL products

Task

Documentation

Integration of Unica Campaign and Unica

Journey

Unica Campaign Administration Guide

and Unica Campaign User Guide

Integration of Unica Campaign and Unica
Interact

Unica Interact Administration Guide

Integration of Unica Deliver with Unica

Journey

Unica Journey User Guide

Integration of Unica Centralized Offer

Management and Unica Journey

Unica Journey User Guide
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Table 4. Get Help

Task Documentation

Unica Journey documentation You can get Unica Journey product doc-
umentation while you logged in Help >

Product documentation.

Unica Journey when installed with other Unica suite products

Before you start installation of Unica Journey you can refer to below sections to plan

Journey installation.

Unica Journey delivery engines for Email

Unica Journey supports Unica Deliver and Unica Link for email delivery. You can use any of
these integration as per your requirements. Please refer to documentation map section for

appropriate documents to refer on this integration.

Unica Journey stack support

Unica suite product support to third party software like databases, operating system,
application server etc., is not exactly same support with Unica Journey. Please refer to

Recommended Software Environments and Minimum System Requirements guide.

For example, If your existing Unica products are installed on stack as below:

* Operating System - AIX 7.1
« Application Server - WebSphere
« Database - DB2

You can install Unica Journey on supported environments as mentioned in Recommended
Software Environments and Minimum System Requirements guide and it would be

compatible with existing Unica products.

Upgrading Unica products and Installing Journey

If you are upgrading from older Unica product version to 12.1.2, you can complete your

upgrade and then install Unica Journey 12.1.2.
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Where to find documentation
You can find the documentation here.

 PDFs: http://doc.unica.com/products/index.php?
showFolder=RW50ZXJwcmlzZQ==&folder=am91cm5leS8xMI8xXzIvZW5fdXM=
* Online Help: https://help.hcltechsw.com/unica/Journey/en/12.1.2/index.html


http://doc.unica.com/products/index.php?showFolder=RW50ZXJwcmlzZQ==&folder=am91cm5leS8xMl8xXzIvZW5fdXM=
http://doc.unica.com/products/index.php?showFolder=RW50ZXJwcmlzZQ==&folder=am91cm5leS8xMl8xXzIvZW5fdXM=
https://help.hcltechsw.com/unica/Journey/en/12.1.2/index.html

Chapter 2. Prerequisites for Unica Journey
Installation or Upgrade

Before installing Unica Journey version 12.1.2, you have to ensure that a few prerequisites

are met.

If a you are a new user, and if you have HCL OneDB, MariaDB, or Microsoft SQL Server as the
database, you can directly install Unica Journey 12.1.2. Ensure that Unica Platform version

12.1.2 is operating correctly.

The supported upgrade path for Unica Journey 12.1.2 are as follows:

Table 5. This table describes the topics that are included in the Unica Journey

Upgrade Guide and the list of sub-topics in the second column.

Base Journey version Upgrade path Tasks to be performed

Unica Journey 12.1.0 or In place upgrade to Unica 1. Upgrade Unica Mar-

12.1.0.x or 12.1.1.x (with Journey 12.1.2 keting Platform to

system tables on Oracle, 12.1.2

MS SQL Server, OneDB, 2. Run upgrade Unica

MariaDB) Journey to 12.1.2 in-
staller

3. Configure Journey
application

4. Deploy Journey appli-
cation

5. Run Journey applica-

tion
Clean Installing Journey on | In place upgrade to Unica 1. Upgrade Unica Mar-
existing Unica environment | Journey 12.1.2 keting Platform and
when you have system ta- required Unica prod-
bles as OneDB, MariaDB ucts to 12.1.2 except

and SQL Server databases Journey.
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Table 5. This table describes the topics that are included in the Unica Journey

Upgrade Guide and the list of sub-topics in the second column. (continued)

2. Run clean installer of
Unica Journey 12.1.2

3. Configure Journey
application

4. Deploy Journey appli-
cation

5. Run Journey applica-

tion

Note:

1. If users do not have Journey already installed on existing Unica environment
with Oracle database, then they need to install Journey version 12.1. and then
upgrade Unica Journey to 12.1.2. or they need to install Journey version 12.1.
then version v12.1.1 and then upgrade Unica Journey to 12.1.2.

2. If you do not have Journey already installed on existing Unica environment
with either MS SQL Server, OneDB or MariaDB database then you can install

Journey version 12.1.2 directly as clean install.

To prerequisites for installation, or upgrade, of Unica Journey are as follows:

1. Ensure that all users are logged out.

2. Stop Unica Journey, Unica Platform, and all applications that are deployed with it.
Also, stop all other components, for example Journey Engine, Kafka server, etc.

3. Undeploy Unica Platform and Unica Journey web application from the application
server.

4. Stop the application server and clean the application server cache.

5. Back up the Unica Platform and Unica Journey database and file system directory to

any temporary directory.



Chapter 3. New features and changes in
version 12.1.2

In Unica Journey 12.1.2, we have introduced some new features, and we have made

changes to some existing features or functionality.

The following list mentions the support for new platforms, in Unica Journey 12.1.2:

* Supports IBM WebSphere Application Server and Red Hat JBoss Enterprise
Application Platform.

« Supports Kafka on windows operating system. To configure Kafka on
Windows operating system, see https://support.hcltechsw.com/csm?
id=kb_article&sysparm_article=KB0085551.

The following list mentions the new features, and the changes to existing features, in Unica

Journey 12.1.2:

- Integrated Contact Management-Global Contact Policy in Journey

Contact Center is a place for marketers to define the contact preference, customer
preference, privacy management in different geo e.g. Business Hours, Business days,
Holidays etc in different geographies. Journey now allows configuration at each
touchpoint to follow and execute communications by the Global settings configured in
Contact Center with an option to bypass the Contact Center rules.

« Integrated Contact Management-Channel Capacity handling in Journey

Capacity per channel (Email, SMS, etc) can be defined in the Contact Center. Journey
can now be configured at each touchpoint to process with channel capacity defined in
the contact center or bypass it.

« Support for Nested JSON in Entry Sources

Journey Data Definition now has support for nested JSON as entry source. Nested
JSON is formatted by CIF and can be then mapped to Entry Source in Journey and
data can be expected in flat structure in Journeys

« Custom Kafka Topic Entry Source


https://support.hcltechsw.com/csm?id=kb_article&sysparm_article=KB0085551
https://support.hcltechsw.com/csm?id=kb_article&sysparm_article=KB0085551
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New Kafka topic name can be added. After the entry source is created a new topic of
the given name will be created on KAFKA
 Update the TSM url to REST url

User need to update the TMS url from SOAP TMS url to REST url.

* Integrate Mobile Push Channel with Deliver

Journey now provides a new touchpoint for Mobile Push Messaging — contacting
customers on their mobile via Push Messaging. Supports both screen and in-
app messaging. Goals and Performance reports are available for Mobile Push.
Engagement splits can be added based on SENT, DELIVERED and READ events.

* Publish audience to the twitter connector

Journey has a new Twitter connector via Link for uploading audiences to Twitter for
advertising. Ability to create new List or add to existing Lists is supported.

« NBO-Support of Dimension table and Real time attributes not present.

Journey now supports the dimension table attribute under audience level attributes
along with profile attributes. Also, list the real time attributes defined in Interact.

« Allow adding new fields in DD even if it is in use

Journey now allows adding new fields to Data Definitions even if the Data definition is
in use.

« Journey Duplication should include all touchpoint configurations

Journey Duplication now includes all touchpoint configurations including Deliver.

« Journey templates should save all configuration

Journey templates now save all configuration information including touchpoints,
goals, milestones, data definitions and entry source.
» Add Search in Templates

Journey templates can now be searched including Name, Code, Description

» Add Folder Support in Templates

Folder support is now provided for Templates and they can be moved to different
folders.

« Data definition should support date formats with delimiters other than space



Unica Journey V12.1.2 Release Notes | 3 - New features and changes in version 12.1.2 | 10

Journey data definition date formats now support “.” (dots), “/” (slash), “-“ (hyphen)
 Packaging Journey templates
With this release, Journey has five new templates for different use-cases.
o Prescription Home Delivery Acquisition Journey
= Convert consumers from filling maintenance medications at retail
pharmacies to home delivery.
» Message Advantages of 3 months supply, Auto Refill, Access to
Pharmacists, etc.
= Message will be to leverage self-serve enrollment options or call into the
call center.
» Set communication timing to be in sync with medication fill dates that
come due (ex. The last outbound call should be before the next fill date)
= Convert consumers from filling maintenance medications at retail
pharmacies to home delivery.
o Increase Wallet Share
= Boost revenue by driving first-time purchase, and increasing upsell and
cross-sell purchases. This accelerator leverages gamification strategy
to direct customers from their first-time purchase towards a small upsell
purchase, then large upsell purchase, and finally a cross-sell bundle
purchase. This accelerator can be tailored for any upsell or cross-sell
campaign: product upgrades, vacation upgrades and add-ons, account
upgrades and add-ons.
o CART ABANDONMENT
» Increase your conversion rate. Send reminders and incentives to
customers who have abandoned their cart or form submission.
This accelerator can be tailored for any cart submission, application
submission, or form submission: product purchase or inquiries, loan
applications, profile updates.
> DYNAMIC eNEWSLETTER
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= Build brand awareness through a personalized customer e-newsletter.
Incentivize customers to stay engaged by encouraging them to enroll
and set personal preferences. This accelerator can be tailored for any
enroliment-based newsletter.

> Event Marketing

= Drive ticket sales for your events. Engage your customers and resellers
each step of the way with ticket purchase announcements, reminders,
event teasers, and satisfaction surveys, all while monitoring your business
goals. This accelerator can be tailored for any reservation-based or ticket-
based events centered on specific dates: vacation packages, concerts,

conferences, and more



Chapter 4. Fixed Defects

The following table lists the defects fixed in Unica Journey 12.1.2:

Defect ID Description

HMA-330857 In draft journey User not able to save deliver touchpoint if
user adds same offer multiple times in deliver communica-
tion.

HMA-330856 Deliver update scenarios support

HMA-330775 Touchpoint edit for Link in upgrade

HMA-330774 Offer Edit for Deliver touchpoint

HMA-329702 Journey Import / Export - Security Permission, Track histo-
ry/comments, Confirmation popup and QA to Prod import
export

HMA-328602 Pause a published journey - Not able to save journey when

we delete any touchpoint that had responses



Chapter 5. Known issues

The following table lists the known issues in Unica Journey 12.1.2:

Defect ID Known Issue

HMA-333396 Journey - Mobile app change from deliver end

HMA-330969 Journey performance regression run 12.1.2

HMA-329896 Journey Performance

HMA-329895 Refactoring of Journey engine and web logs contents- un-
necessary journey execution errors/information is getting
available

HMA-330727 In Oracle database when you have journey system and re-
ports schema tables are in the same schema then you may
face issue with CREATE TABLE AudienceReports SQL. This
can be resolved by changing the constraint name "Journey-
Audience_json" to some other name for example: "Journey-
Audience_json_1"

HMA-334286 Global Preferance: For non set communication days on
journey stats its showing waiting reason as "Invalid commu-
nication time"

HMA-334480 Facebook version for 12.1.1 and 12.1.2is V11.0

HMA-334130 Journey system schema procedure need to compiled manu-
ally on Oracle Database.

HMA-334459 Zookeeper installed by Journey installer is not getting start-
ed.

HMA-334560 offsets.topic.replication.factor=1 property from the kafka
server.properties get commented in clean as well as over-
write installation.
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Defect ID

Known Issue

HMA-334549

Edit issue when single external source is mapped to same

journey entry source

HMA-334598

Deliver email touch point: Unable to map PF fields while
deliver email template is changed and PFs are added / re-

moved on Deliver side

HMA-334597

Deliver - Advance editor - PFs not available in Journey for
email template with personalization fields in subject line

variables

HMA-334614

When Journey that has preferences configured on Journey
or in any touchpoints and then template is created from this
Journey and new Journey is created the Journey will not

have any preferences retained

HMA-334653

Facebook, GoogleAds, Salesforce data is stuck after up-

grade when we send the new data

HMA-334679

MariaDB - 12.1.2 -clean installation - In installation log

showing db script error

HMA-334677

For One db clean installation showing sql script error in logs

HMA-334692

Audience stuck in at journey event topic after upgrade

HMA-334725

Control Center- If Channel capacity is not available for any
channel - in journey its not showing message for capacity -

its showing message regarding invalid time

HMA-334613

Journey with preferences configured on timezone and
channels - When template is created with this journey, new
journey does not have the preferences at journey level nor

at the touchpoints

HMA-334611

REGBB- Journey is not getting completed with date based

goal
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Defect ID Known Issue

HMA-333490 REGBB- (Docker Tomcat) For linkedin not showing states
count

HMA-332068 Getting Folder does not exist on Template listing page

HMA-334727 Journey not recommends to edit the global preference time
zone in Contact center if that GP is configured with Journey




Chapter 6. Before you contact HCL technical
support

If you encounter a problem that you cannot resolve by referring the documentation, your
company's designated support contact can log a call with HCL technical support. Use these

guidelines to ensure that your problem is resolved efficiently and successfully.

If you are not a designated support contact at your company, contact your HCL

administrator for information.

Information to gather

Before you contact HCL technical support, gather the following information:

« A brief description of the nature of your issue.

« Detailed error messages that you see when the issue occurs.

« Detailed steps to reproduce the issue.

« Related log files, session files, configuration files, and data files.

« Information about your product and system environment, which you can obtain as

described in "System information."

System information

When you call HCL technical support, you might be asked to provide information about your

environment.

If your problem does not prevent you from logging in, much of this information is available

on the About page, which provides information about your installed HCL applications.

You can access the About page by selecting Help > About. If the About page is not
accessible, check foraver si on. t xt file that is located under the installation directory for

your application.

Contact information for HCL technical support
For ways to contact HCL technical support, see the HCL technical support website:

https://www.hcltech.com/products-and-platforms/contact-support


https://www.hcltech.com/products-and-platforms/contact-support
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